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Chip Planner Overview
This chapter describes how to use the Chip Planner and the Timing Closure Floorplan 
(for devices not supported by the Chip Planner) for design analysis. 

Chip Planner Overview
The Chip Planner provides a visual display of chip resources. It can show logic 
placement, LogicLock regions, relative resource usage, detailed routing information, 
fan-in and fan-out connections between nodes, timing paths between registers, and 
delay estimates for paths. With the Chip Planner, you can view critical path 
information, physical timing estimates, and routing congestion.

You can also perform assignment changes with the Chip Planner, such as creating and 
deleting resource assignments, and post-compilation changes like creating, moving, 
and deleting logic cells and I/O atoms. By using the Chip Planner in conjunction with 
the Resource Property Editor, you can change connections between resources and 
make post-compilation changes to the properties of logic cells, I/O elements, PLLs, 
and RAM and digital signal processing (DSP) blocks. With the Chip Planner, you can 
view and create assignments for a design floorplan, perform power and design 
analyses, and implement ECOs in a single tool. 

f For details about how to implement ECOs in your design using the Chip Planner in 
the Quartus II software, refer to the Engineering Change Management with the Chip 
Planner chapter in volume 2 of the Quartus II Handbook.

Stratix III — v

Stratix II — v

Stratix II GX — v

Stratix — v

Stratix GX — v

Cyclone® III — v

Cyclone II — v

Cyclone — v

HardCopy® II — v

MAX® IIZ — v

MAX II — v

MAX 7000 v —

ACEX® v —

APEX™ II 
APEX 20KC 
APEX 20KE

v —

FLEX® 10K 
FLEX 10KA
FLEX 10KE
FLEX 6000 v —

Table 12–1. Chip Planner Device Support (Part 2 of 2)

Device Family Timing Closure Floorplan Chip Planner
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Starting the Chip Planner 
To start the Chip Planner, on the Tools menu, click Chip Planner (Floorplan & Chip 
Editor). The following methods can also be used to start the Chip Planner:

■ Click the Chip Planner icon on the Quartus II software toolbar

■ Use the right-click menu from the following sources and use the Locate menu:

■ Design Partition Planner

■ Compilation Report

■ LogicLock Regions window

■ Technology Map Viewer

■ Project Navigator window

■ RTL source code

■ Node Finder

■ Simulation Report

■ RTL Viewer

■ Report Timing panel of the TimeQuest Timing Analyzer

1 If the device in your project is not supported by the Chip Planner and you attempt to 
start the Chip Planner, the following message appears: Can’t display Chip 
Planner: the current device family is unsupported. Use the Timing 
Closure Floorplan for these devices.

The Chip Planner Toolbar
The Chip Planner gives you powerful capabilities for design analysis with a 
user-friendly GUI. Many functions within the Chip Planner can be selected or 
performed from the menu items or by clicking the icons on the toolbar. Figure 12–1 
shows an example of the Chip Planner toolbar and provides descriptions for 
commonly used icons available from the Chip Planner toolbar.
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1 You can customize the icons present on the Chip Planner toolbar by clicking 
Customize Chip Planner on the Tools menu (if the Chip Planner window is 
attached), or by clicking Customize on the Tools menu (if the Chip Planner window is 
detached).

Chip Planner Tasks and Layers
The Chip Planner has predefined tasks that enable you to quickly implement ECO 
changes or manipulate assignments for the floorplan of the device. To select a task, 
click on the task name in the Task menu. The predefined tasks in the Chip Planner are:

■ Floorplan Editing (Assignment)

■ Post-Compilation Editing (ECO)

■ Partition Display (Assignment)

■ Partition Planner

■ Routing Congestion (ECO)

■ Clock Regions (Assignment)—available for Stratix IV, Stratix III, Stratix II, 
Stratix II GX, Cyclone III, Cyclone II, and HardCopy II devices only

Figure 12–1. Chip Planner Toolbar

Detach Window
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Highlight Routing
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Show Delays

Equations
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Check and Save All Netlist Changes
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■ Power Analysis (Assignment)—available for Stratix IV and Stratix III devices 
only

In the Chip Planner, layers allow you to specify the graphic elements that are 
displayed for a given task. You can turn off the display of specific graphic elements to 
increase the window refresh speed and reduce visual clutter when viewing complex 
designs. The Background Color Map can indicate the Block Utilization, Routing 
Utilization, Physical Timing Estimate, I/O Banks, or the High speed-Low power 
Tiles. When you select Design Partition Planner in the Background Color Map 
settings, the resources used by each partition are displayed in the Chip Planner with 
the same colors used for these partitions in the Design Partition Planner. You can 
access the Design Partition Planner on the Tools menu. For example, Routing 
Utilization indicates the relative routing utilization, and Physical Timing Estimate 
indicates the relative physical timing.

Each predefined task in the Chip Planner has a Background Color Map, a set of 
displayed layers, and an editing mode associated with it. Click the Layers icon 
(shown in Figure 12–1) to display the Layers Settings window (Figure 12–2). In this 
window you can select the layers and background color map for each task.

Figure 12–2. Layers in the Chip Planner 

Layers
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The Chip Planner operates in either Assignment or ECO mode. You can use either of 
these modes to perform design analyses. Use the Floorplan Editor (Assignment) task 
in the Assignment mode to manipulate LogicLock regions and location assignments 
in your design. The Post Compilation Changes (ECO) task in ECO mode allows you 
to implement ECO changes in your design. The Partition Display (Assignment) task 
allows you to view the placement of nodes and color-codes the nodes based on their 
partition. When you select the Clock Regions (Assignment) task, you can see the 
regions in your device that are driven by global clock networks. The Power Analysis 
(Assignment) task allows you to view high and low power resources in Stratix IV and 
Stratix III devices.

f For more information about the ECO mode of operation, refer to the Engineering 
Change Management with the Chip Planner chapter in volume 2 of the Quartus II 
Handbook.

You can also create and save your own custom tasks. When you create a custom task, 
you can turn on or off any layer in your task. Layers can be turned on or off by 
checking the appropriate box located next to each layer. You can also select different 
Background Color Maps to be used for your custom task. After selecting the required 
settings, click Save Task As to save your custom task.

LogicLock Regions
LogicLock regions are user-defined regions within the device. Normally, LogicLock 
region are rectangular in shape. However, you can also create regions that are 
effectively non-rectangular in shape. 

You can use LogicLock regions to create a floorplan for your design. Your floorplan 
can contain several LogicLock regions. A LogicLock region is defined by its size 
(height and width) and location (where the region is located on the device). You can 
specify the size or location of a region, or both, or the Quartus II software can generate 
these properties automatically. The Quartus II software bases the size and location of 
a region on the region’s contents and the module’s timing requirements. Table 12–2 
describes the options for creating LogicLock regions.

Table 12–2. Types of LogicLock Regions 

Properties Values Behavior

State Floating 
(default), 
Locked

Floating regions allow the Quartus II software to determine the region’s location on the device. 
Locked regions represent user-defined locations for a region and are shown with a solid 
boundary in the floorplan. A locked region must have a fixed size.

Size Auto 
(default), 
Fixed

Auto-sized regions allow the Quartus II software to determine the appropriate size of a region 
given its contents. Fixed regions have a user-defined shape and size.

Reserved Off 
(default), 
On, Limited

The reserved property allows you to define whether the Fitter can use the resources within a 
region for entities that are not assigned to the region. If the reserved property is turned on, only 
items assigned to the region can be placed within its boundaries. When you set it to limited, the 
Fitter does not place any logic from the parent region. 

Origin Any 
Floorplan 
Location

The origin is the origin of the LogicLock region’s placement on the floorplan. For Arria GX, 
Stratix, and Cyclone series devices, and MAX II devices, the origin is located in the lower left 
corner. For other Altera® device families, the origin is located in the upper left corner.
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1 The Quartus II software cannot automatically define a region’s size if the location is 
locked. Therefore, if you want to specify the exact location of the region, you must 
also specify the size. 

f You can use the Design Partition Planner in conjunction with LogicLock regions to 
create a floorplan for your design. For more information about using the Design 
Partition Planner, refer to the Quartus II Incremental Compilation for Hierarchical and 
Team-Based Designs and the Best Practices for Incremental Compilation Partition and 
Floorplan Assignments chapters in volume 1 of the Quartus II Handbook.

Creating LogicLock Regions
After you perform either a full compilation or analysis and elaboration on the design, 
the Quartus II software displays the hierarchy of the design. On the View menu, click 
Project Navigator. With the hierarchy of the design fully expanded, as shown in 
Figure 12–3, right-click on any design entity in the design and click Create New 
LogicLock Region to create a LogicLock region.

Placing LogicLock Regions
A fixed region must contain all resources required for the module. Although the 
Quartus II software can automatically place and size LogicLock regions to meet 
resource and timing requirements, you can manually place and size regions to meet 
your design requirements. To do so, follow these guidelines:

■ Place LogicLock regions with pin assignments on the periphery of the device, 
adjacent to the pins. For the Arria GX, Stratix, and Cyclone series of devices and 
MAX II devices, you must also include the I/O block within the LogicLock 
Region.

■ Floating LogicLock regions cannot overlap.

Figure 12–3. Using the Project Navigator to Create LogicLock Regions
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■ Avoid creating fixed and locked regions that overlap.

1 If you want to import multiple instances of a module into a top-level design, you must 
ensure that the device has two or more locations with exactly the same device 
resources. If the device does not have another area with exactly the same resources, 
the Quartus II software generates a fitting error during compilation of the top-level 
design.

1 When you import a LogicLock region, the Quartus II software changes the property to 
“floating” and assigns a new unique name. You can change the property to “fixed” to 
guarantee the same placement achieved previously. You can import or export 
LogicLock regions across devices within a family but not between families.

Placing Device Features into LogicLock Regions
A LogicLock region includes all device resources within its boundaries, including 
memory and pins. You can assign pins to LogicLock regions; however, this placement 
puts location constraints on the region. When the Quartus II software places a floating 
auto-sized region, it places the region in an area that meets the requirements of the 
LogicLock region’s contents.

1 Pin assignments to LogicLock regions are effective only in fixed and locked regions. 
Pins assigned to floating regions do not influence the region’s placement.

Only one LogicLock region can claim a device resource. If the boundary includes part 
of a device resource, the Quartus II software allocates the entire resource to the 
LogicLock region.

LogicLock Regions Window
The LogicLock window consists of the LogicLock Regions window (Figure 12–4) and 
the LogicLock Region Properties dialog box. Use the LogicLock Regions window to 
create LogicLock regions and assign nodes and entities to them. The dialog box 
provides a summary of all LogicLock regions in your design. In the LogicLock 
Regions window, you can modify a LogicLock region’s properties size, state, width, 
height, origin, and whether the region is a reserved region. The LogicLock Regions 
window also has a recommendations toolbar at the bottom. Select a LogicLock region 
from the drop-down list in the recommendations toolbar to display the relevant 
suggestions to optimize that LogicLock region. When the region is back-annotated, 
the placement of each node within the region is relative to the region’s origin, and the 
region’s node placements are maintained during subsequent compilations.

1 The origin location varies, depending on the device family. For Arria GX, Stratix, and 
Cyclone series devices, and MAX II devices, the LogicLock region’s origin is located 
at the lower-left corner of the region. For all other supported devices, the origin is 
located at the upper-left corner of the region.
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You can customize the LogicLock Regions window by dragging and dropping the 
various columns. Columns can also be hidden.

For designs that target Arria GX, Stratix, and Cyclone series and MAX II devices, the 
Quartus II software automatically creates a LogicLock region that encompasses the 
entire device. This default region is labelled Root_region, and it is effectively 
locked and fixed.

Use the LogicLock Region Properties dialog box to obtain detailed information about 
your LogicLock region, such as which entities and nodes are assigned to your region 
and what resources are required. The LogicLock Region Properties dialog box shows 
the properties of the current selected regions. You can also modify the settings for the 
regions you have created in this dialog box.

1 To open the LogicLock Region Properties dialog box, double-click any region in the 
LogicLock Regions window, or right-click the region and click Properties.

Hierarchical (Parent and Child) LogicLock Regions
You can define a hierarchy for a group of regions by declaring parent and child 
regions. The Quartus II software places a child region completely within the 
boundaries of its parent region, allowing you to further constrain module locations. 
Additionally, parent and child regions allow you to further improve a module’s 
performance by constraining the nodes in the module’s critical path.

To make one LogicLock region a child of another LogicLock region, in the LogicLock 
Regions window, select the new child region and drag and drop it in its new parent 
region.

1 The LogicLock region hierarchy does not have to be the same as the design hierarchy.

You can create both fixed and floating LogicLock regions within a fixed parent 
LogicLock region. A floating child region’s location can float within its parent. If a 
child region is type fixed, its location remains locked relative to its parent’s origin. A 
locked parent region’s location is locked relative to the device. If the child’s location is 
locked and the parent’s location is changed, the child’s origin changes but maintains 
the same placement relative to the origin of its parent. Either you or the Quartus II 

Figure 12–4. LogicLock Regions Window
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software can determine a child region’s size; however, the child region must fit 
entirely within the parent region. Although there is no limitation to the levels of 
hierarchy in LogicLock regions, remember that very complicated hierarchical regions 
might result in some LABs not being utilized; thus, effectively increasing the resource 
utilization in the device.

Reserved LogicLock Region
The Quartus II software honors all entity and node assignments to LogicLock regions. 
Occasionally, entities and nodes do not occupy an entire region, which leaves some of 
the region’s resources unoccupied. To increase the region’s resource utilization and 
performance, the Quartus II software’s default behavior fills the unoccupied 
resources with other nodes and entities that have not been assigned to another region. 
You can prevent this behavior by turning on the Reserved option on the General tab 
of the LogicLock Region Properties dialog box. When this option is turned on, your 
LogicLock region only contains the entities and nodes that you specifically assigned 
to your LogicLock region. When you set the reserved property for a LogicLock region 
to Limited, the Fitter prevents logic from the immediate parent LogicLock region to 
be placed within the assigned area, but it might place other logic in the associated 
region. 

In a team-based design environment, the Limited option is helpful in creating a 
device floorplan. When this option is turned on, each team can be assigned a portion 
of the device floorplan where placement and optimization of each submodule occurs. 
Device resources can be distributed to every module without affecting the 
performance of other modules.

Creating Non-Rectangular LogicLock Regions
You can use the reserved property of LogicLock regions to create regions that are 
effectively non-rectangular in shape. For example, consider a case in which there is 
one LogicLock region under the Root region and two child regions under this region 
(Figure 12–5).

You can set the Reserved property of a LogicLock region to On, Off, or Limited. If 
you create a LogicLock region for Child_Region_1 with its Reserved property set to 
Limited, the Fitter does not place nodes that are members of Parent_Region_1 or 
Child_Region_2 into the boundary of Child_Region_1. However, the Fitter can place 
nodes that are not members of Parent_Region_1 or Child_Region_1 (such as members 
of the Root_Region) into Child_Region_1. On the other hand, if Child_Region_1 is set 
to exclude all non-members, the Fitter can only place nodes that are members of 
Child_Region_1 into the region. 

Figure 12–5. Example 1

Root Region

Parent_Region_1

Child_Region_1 Child_Region_2
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If the Parent Region’s reserved property is turned off, then the Fitter might place 
other logic in the allocated region. 

If you want to create a non-rectangular region as shown in Figure 12–6, you can create 
two rectangular hierarchical LogicLock regions. Turn off the reserved property on the 
parent LogicLock and set the reserved property on the child LogicLock region to 
Limited to prevent the Fitter from placing any logic of the module assigned to the 
parent LogicLock region. Because of this, logic that is external to the parent LogicLock 
region might be placed in the area allocated to the child region. This gives a 
non-rectangular LogicLock region. 

Examples of Non-Rectangular LogicLock Regions Using Reserved Property
The following examples use the design hierarchy shown in Figure 12–7.

Example 1: Creating an L-Shaped Region 
In the design hierarchy example in Figure 12–7, suppose you want to create an 
L-shaped region, such that the Alu1 module is placed completely inside the region, 
and the non-Alu1 nodes can be placed anywhere on the chip (as shown in 
Figure 12–8).

Figure 12–6. Non-Rectangular Region

Required Logic Lock
Region (Parent)

Child
Region

Figure 12–7. An Example Design Hierarchy

Figure 12–8. Creating an L-Shaped Region 

Alu1 Memory

toy_cpu

Alu2

Alu1

Device

Other nodes
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The L-shaped region defines a rectangular region that is carved out by a child 
LogicLock region (Special) to achieve the L-shape effect. The Reserved property of 
this child LogicLock region is set to Limited, such that the Fitter does not require logic 
from members of Alu1 (which is the parent region of the region named Special) 
inside it while letting other nodes in. Not displayed in Figure 12–8, the Alu1 entity 
instance is assigned as a member to the L_Shaped region. This can be achieved by 
creating a hierarchical LogicLock region as shown in Figure 12–9.

Figure 12–10 illustrates the expected fitting results with these LogicLock regions. 
Nodes from the Alu1 entity instance are colored blue, while nodes from the rest of the 
design are colored red. 

Figure 12–9. Hierarchical LogicLock Region
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Example 2: Region with Disjoint Areas
Suppose you want to create a region consisting of two disjoint rectangles (or any 
number of disjoint areas), such that the Alu1 module is placed completely inside the 
region, and the non-Alu1 nodes can be placed anywhere on the chip as shown in 
Figure 12–11.

Figure 12–10. Expected Fitting Results with LogicLock Regions

Figure 12–11. Region Consisting of Two Disjointed Rectangles
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Other nodes
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You can achieve a region with disjoint areas using the following region hierarchy 
example in Figure 12–12.

The disjoint region defines a rectangular region that is carved out by the Special child 
region to achieve the disjoint effect. Notice that the Special region is set to reserved 
“from members of parent region hierarchy” to prevent the Alu1 nodes from being 
placed inside it, while letting other nodes in. The Alu1 entity instance should be 
assigned to the Disjoint LogicLock region.

Figure 12–13 shows the expected fitting results with the LogicLock regions. Nodes 
from the Alu1 entity instance are colored blue, while nodes from the rest of the design 
are colored red and brown.

Excluded Resources
The Excluded Resources feature allows you to easily exclude specific device resources 
such as DSP blocks or M4K memory blocks from a LogicLock region. For example, 
you can specify resources that belong to a specific entity that are assigned to a 
LogicLock region, and specify that these resources be included with the exception of 
the DSP blocks. Use the Excluded Resources feature on a per-LogicLock region 
member basis.

Figure 12–12. Region with Disjoint Areas

Figure 12–13. Expected Fitting Results with the LogicLock Regions
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To exclude certain device resources from an entity, in the LogicLock Region 
Properties dialog box, highlight the entity in the Design Element column, and click 
Edit. In the Edit Node dialog box, under Excluded Element Types, click the Browse 
button. In the Excluded Resources Element Types dialog box, you can select the 
device resources you want to exclude from the entity. When you have selected the 
resources to exclude, the Excluded Resources column is updated in the LogicLock 
Region Properties dialog box to reflect the excluded resources.

1 The Excluded Resources feature prevents certain resource types from being included 
in a region, but it does not prevent the resources from being placed inside the region 
unless the region’s Reserved property is set to On. To inform the Fitter that certain 
resources are not required inside a LogicLock region, define a resource filter.

Additional Quartus II LogicLock Design Features
To complement the LogicLock Regions dialog box and Device Floorplan view, the 
Quartus II software has additional features to help you design with the LogicLock 
regions.

Tooltips
When you move the mouse pointer over a LogicLock region name on the LogicLock 
Regions dialog box, or over the top bar of the LogicLock region in the Chip Planner or 
Timing Closure Floorplan, the Quartus II software displays a tooltip with information 
about the properties of the LogicLock region.

Placing the mouse pointer over Fitter-placed LogicLock regions displays the 
maximum routing delay within the LogicLock region. To turn this feature on, on the 
View menu, point to Routing and click Show Intra-region Delay.

Show Critical Paths
You can display the critical paths in the design by turning on the Show Critical Paths 
option. Use this option with the Critical Paths Settings option to display paths based 
on the Timing Analysis report.

Analysis and Synthesis Resource Utilization by Entity
The Compilation Report contains an Analysis and Synthesis Resource Utilization by 
Entity section, which reports accurate resource usage statistics, including entity-level 
information. This feature is useful when manually creating LogicLock regions.

Path-Based Assignments
You can assign paths to LogicLock regions based on source and destination nodes, 
allowing you to easily group critical design nodes into a LogicLock region. Any of the 
following types of nodes can be the source and destination nodes:

■ Valid register-to-register path, meaning that the source and destination nodes 
must be registers

■ Valid pin-to-register path, meaning the source node is a pin and the destination 
node is a register

■ Valid register-to-pin path, meaning that the source node is a register and the 
destination node is a pin
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■ Valid pin-to-pin path, meaning that both the source and destination nodes are pins

To open the Paths dialog box, on the General tab of the Logic Lock Regions dialog 
box, click Add Path.

1 Both “*” and “?” wildcard characters are allowed for the source and destination 
nodes. When creating path-based assignments, you can exclude specific nodes using 
the Name exclude field in the Paths dialog box. The Quartus II software ignores all 
paths passing through the nodes that match the setting in the Name exclude field. For 
example, consider a case with two paths between the source and destination—one 
passing through node A and the other passing through node B. If you specify node B 
in the Name exclude field, only the path assignment through node A is valid.

You can also use the Quartus II Timing Analysis Report to create path-based 
assignments by following these steps:

1. Expand the Timing Analyzer section in the Compilation Report.

2. Select any of the clocks in the section labeled “Clock Setup:<clock name>.”

3. Locate a path that you want to assign to a LogicLock region. Drag this path from 
the Report window and drop it in the appropriate row in the LogicLock Region 
pane in the Quartus II GUI.

This operation creates a path-based assignment from the source register to the 
destination register as shown in the Timing Analysis Report.

Quartus II Revisions Feature
When you evaluate different LogicLock regions in your design, you might require 
experiments with different configurations to achieve your desired results. The 
Quartus II software Revisions feature provides a convenient way to organize the 
same project with different settings until an optimum configuration is found.

On the Project menu, click Revisions. In the Revisions dialog box, you can create and 
specify revisions. Revision can be based on the current design or any previously 
created revisions. Each revision can have an associated description. Revisions are a 
convenient way to organize the placement constraints created for your LogicLock 
regions.

LogicLock Assignment Precedence
Conflicts can arise during the assignment of entities and nodes to LogicLock regions. 
For example, an entire top-level entity might be assigned to one region and a node 
within this top-level entity assigned to another region. To resolve conflicting 
assignments, the Quartus II software maintains an order of precedence for LogicLock 
assignments. The following order of precedence, from highest to lowest, applies:

1. Exact node-level assignments

2. Path-based and wildcard assignments

3. Hierarchical assignments
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However, conflicts can also occur within path-based and wildcard assignments. 
Path-based and wildcard assignment conflicts arise when one path-based or wildcard 
assignment contradicts another path-based or wildcard assignment. For example, a 
path-based assignment is made containing a node labeled X and assigned to 
LogicLock region PATH_REGION. A second assignment is made using wildcard 
assignment X* with node X being placed into region WILDCARD_REGION. As a result 
of these two assignments, node X is assigned to two regions: PATH_REGION and 
WILDCARD_REGION.

To resolve this type of conflict, the Quartus II software maintains the order in which 
the assignments were made and treats the most recent assignment created with the 
highest priority.

1 Open the Priority dialog box by selecting Priority on the General tab of the 
LogicLock properties dialog box. You can change the priority of path-based and 
wildcard assignments by using the Up and Down buttons in the Priority dialog box. 
To prioritize assignments between regions, you must select multiple LogicLock 
regions. Once the regions have been selected, you can open the Priority dialog box 
from the LogicLock Properties window.

Normally all nodes assigned to a particular LogicLock region reside within the 
boundaries of that region.

Virtual Pins
When you compile a design in the Quartus II software, all I/O ports are directly 
mapped to pins on the targeted device. The I/O port mapping can create problems for 
a modular and hierarchical design as lower-level modules can have I/O ports that 
exceed device pins available on the targeted device. Also, the I/O ports might not 
directly feed a device pin, but instead drive other internal nodes. The Quartus II 
software accommodates this situation by supporting virtual pins. 

The Virtual Pin assignment communicates to the Quartus II software which I/O ports 
of the design module are internal nodes in the top-level design. These assignments 
prevent the number of I/O ports in the lower-level modules from exceeding the total 
number of available device pins. Every I/O port that is designated a virtual pin is 
mapped to either an LCELL or an adaptive logic module (ALM) depending on the 
target device.

1 Bidirectional, registered I/O pins, and I/O pins with output enable signals cannot be 
virtual pins. 

In the top-level design, these virtual pins are connected to an internal node of another 
module. Making assignments to virtual pins allows you to place them in the same 
location or region on the device as that of the corresponding internal nodes in the 
top-level module. This feature has the added benefit of providing accurate timing 
information during lower-level module optimization.

Use the following guidelines for creating virtual pins in the Quartus II software:

■ Do not declare clock pins

■ Nodes or signals that drive physical device pins in the top-level design should not 
be declared as virtual pins
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1 In the Node Finder, setting Filter Type to Pins: Virtual allows you to display all 
assigned virtual pins in the design. From the Assignment Editor, to access the Node 
Finder, double-click the To field; when the arrow appears on the right side of the field, 
click the arrow and select Node Finder.

Using LogicLock Regions in the Chip Planner
You can easily edit properties of existing LogicLock regions or assign resources to 
them in the Chip Planner. You can also create new LogicLock regions using the Chip 
Planner.

Assigning LogicLock Region Content
When you have defined a LogicLock region, you must assign resources to it using the 
Chip Planner, the LogicLock Regions dialog box, or a Tcl script.

You can drag selected logic displayed in the Hierarchy tab of the Project Navigator, in 
the Node Finder, or in a schematic design file, and drop it into the Chip Planner or the 
LogicLock Regions dialog box. Figure 12–14 shows logic that has been dragged from 
the Hierarchy tab of the Project Navigator and dropped into a LogicLock region in the 
Chip Planner.

You can also drag logic from the Hierarchy tab of the Project Navigator and drop it in 
the LogicLock Regions Properties dialog box. Logic can also be dropped into the 
Design Element Assigned column of the Contents tab of the LogicLock Region 
Properties box.

Figure 12–14. Drag and Drop Logic in the Chip Planner
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1 You must assign pins to a LogicLock region manually. The Quartus II software does 
not include pins automatically when you assign an entity to a region. The software 
only obeys pin assignments to locked regions that border the periphery of the device. 
For the Stratix and Cyclone series of devices, and MAX II devices, the locked regions 
must include the I/O pins as resources.

Creating LogicLock Regions with the Chip Planner
In the View menu of the Chip Planner, click Create LogicLock Region. In the Chip 
Planner, click and drag to create a region of your preferred location and size.

Viewing Connections Between LogicLock Regions in the Chip Planner
You can view and edit LogicLock regions using the Chip Planner. Select the Floorplan 
Editing (Assignment) task or select any task with User-assigned LogicLock regions 
setting enabled to manipulate LogicLock regions. 

The Chip Planner shows the connections between LogicLock regions. Rather than 
showing multiple connection lines from one LogicLock region to another, you can 
select the option of viewing connections between LogicLock regions as a single 
bundled connection. To use this option, open the Chip Planner floorplan and on the 
View menu, click Generate Inter-region Bundles.

In the Generate Inter-region Bundles dialog box, specify the Source node to region 
fanout less than and the Bundle width greater than values. 

f For more information about the parameters in the Generate Inter-region Bundles 
dialog box, refer to the Quartus II Help.

Design Floorplan Analysis Using the Chip Planner 
The Chip Planner assists you in visually analyzing the floorplan of your design at any 
stage of your design cycle. With the Chip Planner, you can view post-compilation 
placement, connections, and routing paths. You can also create LogicLock regions and 
location assignments. The Chip Planner allows you to create new logic cells and I/O 
atoms and to move existing logic cells and I/O atoms using the architectural floorplan 
of your design. You can also see global and regional clock regions within the device, 
and the connections between both I/O atoms and PLLs and the different clock 
regions. 

From the Chip Planner, you can launch the Resource Property Editor. The Resource 
Property Editor lets you make changes to the properties and parameters of device 
resources, and modify connectivity between certain types of device resources. 
Changes that you perform are logged within the Change Manager. The Change 
Manager helps you track the various changes you make on your design floorplan, so 
that you can selectively undo the changes if necessary.

f For more information about the Resource Property Editor and the Change Manager, 
refer to the Engineering Change Management with the Chip Planner chapter in volume 2 
of the Quartus II Handbook.
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The following sections present design analysis procedures and views of the Chip 
Planner, which you can use with any predefined task of the Chip Planner (unless 
explicitly stated that a certain procedure requires a particular task or editing mode).

Chip Planner Floorplan Views
The Chip Planner uses a hierarchical zoom viewer that shows various abstraction 
levels of the targeted Altera device. As you increase the zoom level, the level of 
abstraction decreases, thus revealing more detail about your design.

First-Level View
The first level provides a high-level view (LAB level view) of the entire device 
floorplan. You can locate a node and view the placement of that node in your design. 
Figure 12–15 shows the Chip Planner’s Floorplan first-level view of a Stratix device.

Each resource is shown in a different color. The Chip Planner floorplan uses a 
gradient color scheme in which the color becomes darker as the utilization of a 
resource increases. For example, as more LEs are used in the logic array block (LAB), 
the color of the LAB becomes darker.

When you place the mouse pointer over a resource at this level, a tooltip appears that 
describes, at a high level, the utilization of the resource (Figure 12–16).

Figure 12–15. Chip Planner’s First-Level Floorplan View

LABs

MRAM

DSP

M512

M4K

I/Os
Quartus II Handbook Version 9.0 Volume 2: Design Implementation and Optimization © March 2009 Altera Corporation
 



Chapter 12: Analyzing and Optimizing the Design Floorplan 12–21
Design Floorplan Analysis Using the Chip Planner
Second-Level View
As you zoom in, the level of detail increases. Figure 12–17 shows the second-level 
view of the Chip Planner Floorplan for a Stratix device.

At this level, the contents of LABs and I/O banks and the routing channels that are 
used to connect resources are all visible.

When you place the mouse pointer over an LE or ALM at this level, a tooltip is 
displayed (Figure 12–18) that shows the name of the LE/ALM, the location of the 
LE/ALM, and the number of resources that are used with that LAB. When you place 
the mouse pointer over an interconnect, the tooltip shows the routing channels that 
are used by that interconnect. At this level, you can move LEs, ALMs, and I/Os from 
one physical location to another.

Third-Level View
At the third level, which provides a more detailed view, you can see each routing 
resource that is used within a LAB in the FPGA. Figure 12–19 shows the level of detail 
at the third-level view for a Stratix device.

Figure 12–16. Tooltip Message: First-Level View

Figure 12–17. Chip Planner’s Second-Level Floorplan View

Figure 12–18. Tooltip Message: Second-Level View
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From the third level, you can move LEs, ALMs, and I/Os from one physical location 
to another. You can move a resource by selecting, dragging, and dropping it into the 
desired location. At this level, you can also create new LEs and I/Os when you are in 
the post-compilation (ECO) mode.

1 You can delete a resource only after all of its fan-out connections are removed. 
Moving nodes in the Floorplan Editing (Assignment) task creates an assignment. 
However, if you move logic nodes in the Post-Compilation Editing (ECO) task, that 
change is considered an ECO change. For more information about Floorplan 
Assignments, refer to “Viewing Assignments in the Chip Planner” on page 12–37. 

f For more information about performing ECOs, refer to the Engineering Change 
Management with the Chip Planner chapter in volume 2 of the Quartus II Handbook.

Bird’s Eye View
The Bird’s Eye View (Figure 12–20) displays a high-level picture of resource usage for 
the entire chip and provides a fast and efficient way to navigate between areas of 
interest in the Chip Planner. 

Figure 12–19. Chip Planner’s Third-Level Floorplan View
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The Bird’s Eye View is displayed as a separate window that is linked to the Chip 
Planner floorplan. When you select an area of interest in the Bird’s Eye View, the Chip 
Planner floorplan automatically refreshes to show that region of the device. As you 
change the size of the main-view rectangle in the Bird’s Eye View window, the main 
Chip Planner floorplan window also zooms in (or zooms out). You can make the 
main-view rectangle smaller in the Bird’s Eye View to see more detail on the Chip 
Planner floorplan window by right-clicking and dragging inside the Bird’s Eye View.

The Bird’s Eye View is particularly useful when parts of your design that you are 
interested in are at opposite ends of the chip, and you want to quickly navigate 
between resource elements without losing your frame of reference.

Figure 12–20. Bird’s Eye View
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Viewing Architecture-Specific Design Information
With the Chip Planner, you can view the following architecture-specific information 
related to your design:

■ Device routing resources used by your design—View how blocks are connected, 
as well as the signal routing that connects the blocks.

■ LE configuration—View how a logic element (LE) is configured within your 
design. For example, you can view which LE inputs are used; if the LE utilizes the 
register, the look-up table (LUT), or both; as well as the signal flow through the 
LE.

■ ALM configuration—View how an ALM is configured within your design. For 
example, you can view which ALM inputs are used, if the ALM utilizes the 
registers, the upper LUT, the lower LUT, or all of them. You can also view the 
signal flow through the ALM.

■ I/O configuration—View how the device I/O resources are used. For example, 
you can view which components of the I/O resources are used, if the delay chain 
settings are enabled, which I/O standards are set, and the signal flow through the 
I/O.

■ PLL configuration—View how a phase-locked loop (PLL) is configured within 
your design. For example, you can view which control signals of the PLL are used 
with the settings for your PLL.

■ Timing—View the delay between the inputs and outputs of FPGA elements. For 
example, you can analyze the timing of the DATAB input to the COMBOUT output.

In addition, you can modify the following properties of an Altera device with the 
Chip Planner:

■ LEs and ALMs

■ I/O cells

■ PLLs

■ Registers in RAM and DSP blocks

■ Connections between elements

■ Placement of elements

f For more information about LEs, ALMs, and other resources of an FPGA device, refer 
to the relevant device handbook.

Viewing Available Clock Networks in the Device
When you select the Clock Regions (Assignment) from the Task list, you can view 
the areas of the chip that are driven by the global and regional clock networks 
available in the device. This global clock display feature is available only for Stratix IV, 
Stratix III, Stratix II, Stratix II GX, Cyclone III, Cyclone III, and HardCopy II device 
families.
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When you select the Clock Regions task, the Chip Planner displays various types of 
regional and global clocks and the regions they cover in the device. The connectivity 
between clock regions, pins, and PLLs is also shown. Clock regions are shown with 
rectangular overlay boxes with name labels of clock type and index.You can select 
each clock network region by clicking on it. The clock-shaped icon at the top-left 
corner indicates that the region represents a clock network region.

Clock types are listed in the Layer Settings window. You can change the color of the 
clock network in the Chip Planner on the Options page of the Tools menu. 

You can customize your view of the global clock networks by using the layers setting 
in the Chip Planner GUI. You can turn on or off the display of all clock regions with 
the All types option. When the selected device does not contain a specific clock 
region, the option for that category is turned off in the dialog box. Figure 12–21 shows 
the potential fan-in in the Chip Planner.

To trace the possible connectivity to each clock network region, select the clock 
network region and use the Generate Potential Fan-In and Generate Potential 
Fan-Out commands.

If you are interested in locating the clock regions that a pin or PLL can feed, select the 
pin or the PLL, then use the Generate Fan-Out Connections command. Connection 
arrows are drawn from the selected pins or PLLs to their clock regions.

When you use the Generate Fan-In Connections and Generate Fan-Out Connections 
commands, the Chip Planner shows connections that are actually used in the netlist 
for the selected clock region.

Figure 12–21. Potential Fan-In
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Viewing Critical Paths
Critical paths are timing paths in your design that have a negative slack. These timing 
paths can span from device I/Os to internal registers, registers-to-registers, or 
registers-to-devices I/Os. The View Critical Paths feature displays routing paths in 
the Chip Planner, as shown in Figure 12–22. The criticality of a path is determined by 
its slack and is shown in the timing analysis report. Design analysis for timing closure 
is a fundamental requirement for optimal performance in highly complex designs. 
The Quartus II Chip Planner helps you close timing on complex designs with its 
analytical capability.

Viewing critical paths in the Chip Planner helps you analyze why a specific path is 
failing. You can see if any modification in the placement can potentially reduce the 
negative slack. You can display details of a path (to expand/collapse the path to/from 
the connections in the path) by clicking on Expand Connections/Paths button in the 
toolbar, or by clicking on the “+/-” on the label. 

To view critical paths in the Chip Planner, on the View menu, click Critical Path 
Settings. In the Critical Path Settings dialog box, click Show Path (refer to 
Figure 12–23 on page 12–27).

If you are using the TimeQuest Timing Analyzer, you can locate the failing paths 
starting from the timing report. To locate the critical paths, run the Report Timing task 
from the Custom Reports group in the Tasks pane of the TimeQuest GUI. From the 
View pane, which lists the failing paths, you can right-click on any failing path or 
node, and select Locate Path. From the pop-up dialog box, select Chip Planner to see 
the failing path in the Chip Planner.

Figure 12–22. Chip Planner Showing Critical Path
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When viewing critical paths, you can specify the clock in the design you want to view. 
You determine the paths to be displayed by specifying the slack threshold in the slack 
field of the Critical Path Settings dialog box. This dialog box also helps you to filter 
specific paths based on the source and destination registers.

1 Timing settings must be made and a timing analysis performed for paths to be 
displayed in the floorplan.

For more information about performing static timing analysis with the Quartus II 
Classic Timing Analyzer, refer to the Quartus II Classic Timing Analyzer chapter in 
volume 3 of the Quartus II Handbook. For more information about performing static 
timing analysis with the Quartus II TimeQuest Timing Analyzer, refer to the 
Quartus II TimeQuest Timing Analyzer chapter in volume 3 of the Quartus II Handbook.

Viewing Physical Timing Estimates
In the Chip Planner, you can select a resource and see the approximate delay to any 
other resource on the device. After you select a resource, the delay is represented by 
the color of potential destination resources. The lighter the color of the resource, the 
longer the delay.

Figure 12–23. Critical Path Settings for the Chip Planner
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To see the physical timing map of the device, in the Chip Planner, click the Layers 
icon located next to the Task menu. Under Background Color Map, select Physical 
Timing Estimate. Select a source and move your cursor to a destination resource. The 
Chip Planner displays the approximate routing delay between your selected source 
and destination register (Figure 12–24).

You can use the physical timing estimate information when attempting to improve 
the Fitter results by manually moving logic in a device or when creating LogicLock 
regions to group logic together. This feature allows you to estimate the physical 
routing delay between different nodes so that you can place critical nodes and 
modules closer together, and move non-critical or unrelated nodes and modules 
further apart. 

In addition to reducing delay between critical nodes, you can make placement 
assignments to reduce the routing congestion between critical and noncritical entities 
and modules. This allows the Quartus II Fitter to meet the design timing 
requirements. 

1 Moving logic and creating manual placements is an advanced technique to meet 
timing requirements and must be done after careful analysis of the design. Moving 
nodes in the Floorplan Editing (Assignment) task creates an assignment. However, if 
you move logic nodes in the Post-Compilation Editing (ECO) task, that change is 
considered an ECO change. 

Figure 12–24. Chip Planner Displaying Routing Delay
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For more information about Floorplan Assignments, refer to “Viewing Assignments 
in the Chip Planner” on page 12–37. 

f For more information about performing ECOs, refer to the Engineering Change 
Management with the Chip Planner chapter in volume 2 of the Quartus II Handbook.

Viewing Routing Congestion
The Routing Congestion view allows you to determine the percentage of routing 
resources used after a compilation. This feature identifies where there is a lack of 
routing resources. This information helps you make decisions about design changes 
that might be necessary to ease the routing congestion and thus meet design 
requirements. The congestion is visually represented by the color and shading of logic 
resources. The darker shading represents a greater routing resource utilization. 

You can set a routing congestion threshold to identify areas of high routing 
congestion with the Routing Congestion Settings dialog box by selecting the 
Routing Congestion (ECO) task from the drop-down task list or when you select 
Routing Utilization from the layers setting. In the Routing Congestion Settings 
dialog box, set the threshold level for congestion indication and click Apply. You can 
also select the interconnect type you are interested in. All areas that exceed the 
threshold you have set appear in red (Figure 12–25).

Figure 12–25. Areas Exceeding Threshold
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If you are using a HardCopy II device, turn on Routing Congestion to see the routing 
congestion in the device by selecting Routing Utilization from the Layers Settings 
window.

To view the routing congestion in the Chip Planner, click the Layers icon located next 
to the Task menu. Under Background Color Map, select the Routing Utilization map 
(Figure 12–26). Any areas that exceed the threshold appear red. Use this congestion 
information to evaluate if you could modify the floorplan, or make changes to the 
RTL to reduce routing congestion.

Viewing I/O Banks
The Chip Planner can show all of the I/O banks of the device. To see the I/O bank 
map of the device, click the Layers icon located next to the Task menu. Under 
Background Color Map, select I/O Banks. Refer to Figure 12–27. 

Figure 12–26. Viewing Routing Congestion Map in the Chip Planner
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